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File Information Window:

Date Span of All Existing Messages:
This section shows the earliest message date & time in the file on the left, and the most recent
message date & time on the right.

Message File Statistics:
This area shows overall statistics about the message file as it presently stands.

Employee Names:
All employees in the file are listed here, with their specific statistics to the right of each 
employee.

Total Messages for Each Employee:
This is the total number of messages in the file for the selected employee.    It include 
messages marked for deletion as well as all active records.

Active Messages for Each Employee:
The count shown here reflects the messages in the file for that specific employee which have 
not been marked for deletion with the Now Active/Deleted button on the message pad.

Total Messages Read by Employee:
This figure represents the total number of messages for the selected employee which have 
been received, or "read" by that employee.    The marking of this status occurs by using the 
Unread/Received button on the message pad.



Edit On-Screen Message:
The Message Center for Windows maintains a time limit during which a message may be 
edited or modified.    This limit is set in the "System Defaults" dialog box accessed from the 
"Settings" menu.    To edit and on-screen message, YOU MUST CHOOSE "Edit On-Screen 
Message" menu choice from the "File" menu.    

When editing the on-screen message, you are in editing mode, and "EDITING MODE" will 
appear at the top center of the message pad.    You can only modify the call criteria and the 
messageitself.    The employee name, date, time, caller, caller's company, telephone, and 
extension become permanent once a message is saved.

When you are finished editing the message, click on the "Save" button to store your changes.  
If you are not satisfied with the changes yopu have made, click the "Cancel." 



Frequent Caller Maintenance...
The Message Center for Windows maintains a list of Frequent Callers for each employee.    At 
times, you may need to revise, or purge this information.    These modifications are done from the 
Frequent Caller Maintenance dialog box which is selected from the "File" menu.

Employee:
This combobox contains a list of the employees stored in the system.    You must select an
employee to work with first.    This action will load a list of all of the    Frequent Callers for 
the selected employee into the Caller combobox below.

Caller:
This is the place where the Frequent Callers for the selected employee are listed.    Choose 
the appropriate Frequent Caller from the list, and the rest of the edit boxes will be filled 
with the corresponding information.    

Company:
The name of the Frequent Caller's organization.    If the Frequent Caller is not with an 
organization or company, this editbox can be left blank.    Remember that this information 
is what appears on a new message in the "Of:" box, when the message is saved.

Phone Numbers:
The program allows for three phone numbers for each frequent caller.    A work or office 
number is first, a home number is second, and any other number is third.    Only the work 
or office number has a corresponding extension.    
These numbers are loaded into the "Tel:" combobox when this Frequent Caller is selected 
during the creation of a new message, and are listed in that control as "W: " + work phone 
number, "H: " + home phone number, and "O: " + the other number.

If password protection is turned on, this information may be changed only by those to whom the 
frequent caller belongs, or by a Master Access user.    If password protection is turned off, anyone 
can modify this information.    



The Message Pad Diagram
The Message Center for Windows message pad is very easy to use.    The following speed topics 
refer to the diagram below which shows all of the different areas of the pad:

Who Was Called, and When
Unread/Received Button
Now Active/Deleted Button

Employee Status Button
Scan Backward/Forward Buttons
Caller Information
Call Criteria
Note Marker
Message Left By Caller



Attaching a Note to a Message:
The Message Center for Windows allows all users to attach notes to existing telephone messages.
If there is no note attached to the on-screen message, the background color of the marker is the 
same as the background color of the message pad itself (transparent)Once a note is attached to a 
message, a musical note marker appears to the right of the message pad editbox.    This process 
is initiated by double clicking on the note marker, or by choosing the "Add a Note to the On-
Screen Message" menu choice from the "File" menu.    Once this button is chosen, a dialog box 
appears in the left hand panel of the screen.          

The Message Notes dialog box has several items which describe the actions associated with the 
on-screen message:                

Call Return Status:
This is a set of radio buttons which allow the user to mark whether the on-screen messages 
has not yet been returned, the caller's line was busy, the caller was out of the office, or you left
a message.          

History:
In this area, you keep track of the history of your callbacks.    Change the attempt count by 
either entering the number manually in the editbox, or clicking on the "Up" or "Dn" buttons to 
the right of the editbox.    You can also mark the date and time of your message note revision 
by clicking on the Date/Time Now button in the History frame.              

Message Note:
This is your actual notation.    There are several ways to input information here.    You can add 
a dated line to the notation by clicking on the "Add a Dated Line" button under the notation 
editbox, or you can just type the information into the notation box.    The only limitation is that 
this message can only contain 400 characters, spaces, punctuation marks, etc.      

Delete Note Button:
This button is only enabled if there is an existing note for the corresponding message.    
Should you decide to delete the existing notation, click on this button, and then confirm the 
note deletion.    Just remember that once it's gone, it's gone forever.        

OK & Cancel Buttons:
OK saves the changes you have made, and Cancel cancels all changes, if this is an existing 
notation.    Otherwise, OK saves the note, and resets the on-message note marker to the color 
selected from the Personal Preferences area.        

ONLY THE RECIPIENT OR A MASTER ACCESS USER CAN ADD OR DELETE NOTES FROM 
HIS/HER MESSAGES!    ONCE A MESSAGE IS DELETED, IT'S NOTE IS DELETED TOO!              



Save Button
When a new message is being created, or and old message is being edited, the "Add a 
Message" button on the right below the message pad disappears, and is replace by the "Save"
and "Cancel" buttons.

The "Save" button is used to save a new message to the file, or save the edits you have made 
to the existing message.



Cancel Button

When a new message is being created, or and old message is being edited, the "Add a 
Message" button on the right below the message pad disappears, and is replace by the "Save"
and "Cancel" buttons.

The "Cancel" button is used to cancel the entry of a new message, or to discard the edits you 
have made to the existing message.



Employee Maintenance
The Message Center for Windows allows the Master Access user to add, delete, and modify 
existing employee information, as well as current status.    The first step is to choose the "File" 
menu from the main screen, then choose "Employee Info..."    The Limited Access user can only 
change any employee's status, but not add, delete, or modify any existing employee.    These tasks
are reserved for the Master Access user.    Those items marked with an asterisk ( * ) are items 
which cannot be accessed, or allow only limited access,    to a Limited Access user.

Employee ComboBox:
 

The employee ComboBox is the main focus point of employee maintenance..    When an 
employee's name is chosen from the list, a search is initiated which retrieves the selected 
employee's current status and Locator, and loads the name, title, department, extension, and 
initial editboxes for viewing or modification.

Changing Employee Data:*
Employee data can be changed after selecting the appropriate employee from the ComboBox.  
The employee name, title and department can be up to 40 characters each.    Once you have 
made the appropriate changes, click on "OK" and the data will be saved.      IF YOU CHANGE 
THE NAME OF AN EXISTING EMPLOYEE, TMCFW WILL AUTOMATICALLY UPDATE THE 
EMPLOYEE NAME ON ANY CORRESPONDING MESSAGE ALREADY IN THE MESSAGE FILE.
A Limited Access user can only change the Present Status and locator.
PLEASE NOTE: The employee entry named "Non-Employees, Visitors" cannot be changed in 
any way.

Deleting Employees:*
To delete an employee, select the employee to be deleted from the employee ComboBox, click 
on the "Delete" button.    You will then be presented with a confirmation dialog box which gives
you one last opportunity to "Cancel" if you are not happy with your choice.    IMPORTANT: If 
you delete an employee, all related information such as telephone messages, passwords, and 
frequent callers, is deleted as well.    
Also note that the first record, which is a Master Access employee and the second record, 
"Non-Employees, Visitors", which is a Limited Access user,    cannot be deleted, nor can their 
access capabilities be changed.

Adding New Employees:*
When you click on the "New" button, all of the editboxes are blanked and readied for your 
input.    Fill in all of the appropriate information.    Set the status and edit the Locator, then click
the "OK" button to save the employee, or the "Cancel" button to deactivate the new entry 
mode.

Employee's Present Status & Locator:
To change the status of an employee, simply click on the appropriate radiobutton .    (with the 
keyboard, tabbing goes through each of the available radio buttons). Present Status and the 
Locator are used to provide information about that employee when someone else is taking a 
message.    These items are not necessary but are helpful. This information is retrieved not 
only from the Employee Maintenance screen, but also from the Employee Status Button under 
the main message pad.



Employee Status Button:

This button, located underneath the left half of the message pad, activates a message box with
pertinent stats about the selected employee.    When in Normal Mode the message box will 
display the employee's status and location (both set or modified within the Employee 
Maintenance screen), the total number of messages in the file for that employee, as well as 
dates and times of the oldest and most recent messages for that particular employee. 

In New Mode,    the message box will only display the status and locator information about the 
selected employee.

This button is DISABLED when the selected employee is "Non-Employees, Visitors."                



Scan Backward/Forward Buttons:

These buttons are located at the bottom of the Message Pad, flanking the Employee Status 
and Add a Message buttons.      

The    "<"    button scans backward one message for the selected employee.
The    ">"    button scans forward one message for the selected employee.

The    "<<"    button places the oldest message for the selected employee on the pad.
The    ">>"    button puts the most recent message for the selected employee on the pad.



Now Active/Deleted Button:
This button (in the upper right hand portion of the message pad) tells the operator whether or 
not the onscreen message has been marked for deletion.    If marked for deletion, the message 
will be disposed of during the next quick deletion session, or massive deletion session.

The button is a standard gray button with "Now Active" as it's caption if the message is active,
or    "Deleted" if it is marked for deletion.



Note Marker: ( )
The Note Marker is located to the right of the message editbox.    This marker is the color of the 
message pad background when no note for the on-screen message exists,    and when a notation 
is attached to the on-screen message, this marker's color is that chosen from the screen color 
selection module, which can be accessed by choosing the main menu item "Settings, then 
"Screen Colors."    The Note Marker signifies, by color, that a note has been attached to the on-
screen message.



Unread/Received Button:
This button (in the upper left hand portion of the message pad) tells the operator whether or 
not the onscreen message has been received by the recipient, or is it presently unread.

The button is a standard Windows button with "Unread" as the caption if the message is 
unread, or    "Received" if the message has been dispatched to the recipient.



Caller Information:
This section tells the recipient who called, what company the caller is from, and at what 
number the caller can be reached.      If password protection is enabled, only a Master Access 
user can store this information at the end of the message entry session as a Frequent Caller 
for the selected employee.    If, on the other hand, password protection is turned off, anyone 
can enter a frequent caller.    After the first input to the frequent caller list, entering this 
information later into a new message is as easy as a click in the frequent caller box.                



The Message:
The message area itself, which is located at the bottom of the message pad,    is a multiline 
editbox in which you type the message for the recipient.    This message is limited to 300 
characters, including spaces and punctuation.      



WHO was called, and WHEN:
This section of the message pad, above the PhoneGram heading, includes the message 
recipient's name, as well as the date and time the call came in.                



Call Criteria:
This section is comprised of seven checkboxes, which describe the nature of the call, and the 
action requested by the caller.    You can use the Tab or Shift+Tab keys to jump through the 
criteria checkboxes, and the space bar toggles them on and off.

The seven checkboxes show what the caller did, will do or wants the recipient to do:
    

Telephoned Please Call 
Called to See You Will Call Again
Wants to See You Urgent
Returned Your Call



General Information
The Message Center for Windows is a comprehensive telephone messaging system.    The 
program is provided as a multi-user network version, with two types of access:    Master Access 
and Limited Access.

If password protection is enabled, those users granted Master Access can use ALL of program's 
capabilities.    A user granted only Limited Access can view and print his/her messages, as well as 
view his/her frequent caller information.    The Limited Access user cannot access other peoples' 
messages or frequent callers, nor can he physically delete any messages from the file.    They can,
however, mark his/her own messages for deletion.

The Message Center for Windows ("TMCFW") provides many nice features and conveniences. 
Among these are:

TMCFW's message pad has a familiar look.
TMCFW alerts you when you have a new message waiting.
TMCFW maintains a telephone extension directory which displays from the Employee 
Status Button and in the Employee Maintenance screen.
TMCFW has extensive password protection which isolates messages and message 
notations for individuals, and keeps others from seeing your frequent caller lists.    
Password protection may be disabled, for smaller offices where security is not key.
TMCFW    tracks whether a message has been dispatched to the recipient by means of 
a tracking button on the message pad called the Unread/Received Button.    In addition,
TMCFW offers the user the option of displaying only those messages that have not 
been read, or all messages.    The startup default is Show All Messages.
TMCFW allows the recipient of a message to attach hidden message notes to the on-
screen message.
TMCFW provides easy ways for users to maintain their messages.
TMCFW allows users to modify, delete, or add to their own frequent caller lists.
TMCFW prints beautiful graphical message slips on plain paper.    It can also print 
straight lists, although we feel that the slips are very elegant!
TMCFW maintains preferences by user, if password protection is turned on, so that it 
performs the way you like to work.    Minor alert messages can be disabled, so that 
more proficient users can speed along at a faster clip.    Notification sounds can be 
disabled, too.
TMCFW has hundreds of other protections and features that you will discover as you 
go along.



Menus:
Most of the functions in The Message Center for Windows are carried out in the main window.    
There are only three menus because the main window is so comprehensive.    The menus lead you
primarily to maintenance functions...

File
This menu provides the user with file related choices such as File Info, Deleting Messages, 
Print Messages, etc.

Settings
This menu provides the user with the ability to change certain Message Center for Windows 
system defaults.

Help
The Help menu allows the user to choose between this help file or an "About" box.



Keeping the Message Center Fast:
As in any database application, the bigger the files get, the slower searches for specific data 
become.    The Message Center for Windows is no exception.    

Since the employee database is scanned infrequently within the workings of the program, the 
database's physical size only affects operation at limited points in the application.    

The message database, on the other hand, grows daily, so purging the messages often will make 
a vast difference in search speed.    This is due to the fact that each time an employee is selected 
from the Employee ComboBox, a search is made through all messages to isolate specific 
messages for that employee.    There more messages there are, the more time it will take.    The 
same applies to Frequent Callers.    It doesn't make sense to have everyone's mother on the list, 
nor callers who have not called for a while.    Occasional purging of the Frequent Callers will add 
speed to all searches.



Finding Existing Messages:

In    The Message Center for Windows finding an existing telephone message is easy.    Simply 
select the correct employee from the "To:"    ComboBox on the main message pad.    The message 
files are then searched and loaded into the "Who:" ComboBox by date, time, and caller.    The most
recent message for the selected employee will be displayed on the pad.      If "Unread Messages 
Only" in the "Settings" menu is checked, ONLY those MESSAGES which have NOT been 
DISPATCHED to the recipient will appear on the screen.

At the lower right hand corner of the pad is a message counter which displays which message, 
out of how many messages, is displayed on the screen at the time.

You can use the Scan Backwards/Forward Buttons to skip through the messages for the selected 
employee, or you can choose a specific message from the "Who:" ComboBox directly.

When you are scanning forwards or backwards, if minor notifications, set from the Settings - 
Personal Preferences menu choice are set on, you will be notified when you reach the last and 
first messages respectively.



File Menu:
The Message Center for Windows has several files which it maintains for normal operations.    
There is only one set of files which are constantly updated and purged.    File information and 
maintenance is handled from this menu.    Those menu items marked by an asterisk ( * ) are only 
available to those employees with Master Access privileges, but only if, the password protection 
system is enabled.    
If the password protection system is not enabled, all users are considered Master Access users, 
and have access to all parts of the system.

File Info *
Provides general statistics and information about the system files.

Employee Info... (* with exceptions)
Master Access users have complete control over the addition, deletion, and modification of 
employees in the file.    Although Limited Access users can choose this menu item, they can 
only modify an employee's present status.    They have no access to the manipulation 
capabilities.
From here, the Master Access user can add new personnel, delete existing personnel, and 
change an employee's listed status. 

Add a Note to the On-Screen Message...
Each message can have a corresponding notation attached.    This note describes the actions 
taken regarding the call, and remains with the message until either the note, or the message is
deleted.

Edit the On-Screen Message...
After a message is created, there is a certain time period in which that message may be 
modified.    This limit was set during the Message Center Setup, and can be modified from the 
"Settings" menu item, then the "System Defaults" menu choice.    

Only the call criteria and the message itself may be modified.    Once the proper changes have 
been made, choose the "Save" button to store the edits into the file.

Frequent Caller Maintenance...
Frequent Caller information is maintained for all of the employees entered into the system.    
This information makes entering a message from someone who calls often, a snap.    This 
module allows the user to modify his/her frequent caller information.    A Master Access user 
can modify any frequent caller information, while a Limited Access user can only manipulate 
the information specifically on their own frequent callers.

Delete Messages...*
The user will be presented with a dialog box where the type of message deletion is 

determined.    

Quick Delete*
This choice deletes all of the existing messages which have been marked by users for 
deletion.    You will not be presented with any choices other than "OK" or "Cancel."    All 
messages marked will be deleted, as well as their corresponding notes. 

Print Messages...
You are presented with the Print Messages dialog box where either all or selected messages 
can be printed.

Printer Setup...



This menu item invokes the printer setup driver for the selected Windows printer.

Phone Extension Directory...
In this dialog box, you can get the in-house telephone extension, title, and department of all 
employees on file.

Exit
From here, the user can close down all of the active files, and end the Message Center for 
Windows session.



Help Menu:
The Message Center for Windows has two choices in the Help Menu, Help and About

Help 

This menu choice brings you to this interactive Windows help file.

Using Help 

This menu choice brings you to the interactive Help on Windows Help file (information and 
instructions on using the Winhelp program).

About...

Displays the Message Center for Windows logo, version, copyright notice, current user 
information, and general system information.



Settings Menu:
The Message Center for Windows has several defaults which can be set.    These defaults are used
throughout the program.

Show All Messages...
This menu item works in tandem with the menu item below it called "Show Only Unread 
Messages."    If this menu item is checked and disabled, all messages ARE being shown on the
screen.      There is no permanency to this choice. . . it is simply a toggle for viewing purposes 
only.    

Show Only Unread Messages...
This menu item, which works in tandem with the menu item above it, "Show All Messages," 
allows a user to filter out the "Received" messages on the display.    

When ALL messages are being shown on the screen, this menu item will be active and 
unchecked.    Clicking on it envokes the filter, as well as causing this menu item to become 
checked but disabled under the "Settings" menu. There is no permanency to this choice. . . it 
is simply a toggle for viewing purposes only.    

System Defaults...
These settings are global, regardless of whether password protection is turned on or not!    
They affect everyone using the Message Center.

Personal Preferences...
These are preferences which apply to each specific user, if, and only if, password protection is
turned on.      

Passwords...

The Passwords section allows the user to maintain or modify his/her password.    The Master 
Access user, if password protection is turned on, can change anyone's password, but the 
Limited Access user can only modify his/her own entry key word.

Screen Colors... 

Screen Colors are maintained for each user, only when password protection is turned on.    
This menu choice allows you to change those colors.    If password protection is turned off, 
the changes made in this section apply to everyone on the system.



Screen Colors...
Screen colors are maintained for each user, but only when password protection is turned on.    
This dialog box initializes with your current message pad color settings.    A single click with 
the mouse on one of the screen regions will show the present color of the selected choice 
below in the demonstration window.    A double-click on the screen region name in the listbox 
will invoke the color selection dialog box.    Choose your new color, and click on "OK", unless 
you decide to leave the selection as it was, in which case choose "Cancel."    The color 
selection dialog will close and your selection will be reflected in the demonstration window.

Once you are satisfied with your choices, click on the "OK" button.    If you decide not to make 
the changes after all, click on the "Cancel" button.    The changes you have made will be 
reflected in the system immediately.

If password protection is turned off, whatever changes you make in this dialog affects 
everyone's color schemes.



Passwords...
If password protection is turned off from the "System Defaults" dialog box, this section of the 
program will not initialize, and you will be notified that it is disabled.

Passwords are an important feature of the Message Center for Windows.    The control how and 
who can have access to messages within the system.    Users with Master Access capabilities can 
utilize and manipulate all aspects of the program.    Limited Access users have access to some, 
but not all of the Message Center's features.

A Limited Access user, for example, cannot enter a frequent caller during the entry of a new 
message.    Master Access users, on the other hand, are prompted that the "new" frequent caller is
not on the employee's frequent caller list, and asked whether the new caller should be added.

To change your password, choose "Passwords..." from the "Settings" menu.    You will be 
prompted to enter your existing password.    If you have entered your password correctly, you will 
be prompted to enter your new password.    

PLEASE NOTE!    PASSWORDS ARE CASE SENSITIVE!    In other words, if your password is 
"BoB", you will get an error message if you enter "Bob," and will not be granted access to the 
system.    Passwords are limited to 7 characters, numbers and spaces.    If password protection is 
enabled, passwords cannot be left blank.



Show Only Unread Messages
This menu item, the second in the "Settings" menu, allows the user to "filter out" all of the 
messages that have been marked as received with the Unread/Received Button.    

When the Message Center initially loads, this menu item is active and not checked, signifying that 
no filter is in force and that all messages are being displayed.    

If this menu item is enabled, as soon as it's clicked upon, it becomes disabled and checked, while 
the "Show All Messages" menu choice becomes active but not checked.



Show All Messages
This menu item, the first in the "Settings" menu, allows the user to "filter out" all of the messages 
that have been marked as received with the Unread/Received Button.    

When the Message Center initially loads, this menu item is checked but disabled, signifying that 
no filter is in force and that all messages will be displayed.    

If this menu item is enabled, as soon as it's clicked upon, it becomes disabled and checked, while 
the "Show Only Unread Messages" menu choice becomes enabled but not checked.



System Defaults...
System Defaults apply to everyone on the system, regardless or whether password protection is 
turned on or off.    There are three components to the System Wide Defaults dialog box.    These 
are:

Message Editing Time:
This section controls the amount of time in which a message may be changed after initial 
input.    
The minimum is 0 (zero) minutes.    If the editing time is set to zero, messages are 
permanent as soon as they are saved.    The maximum number for this setting is 720 
(seven hundred twenty) minutes, or 12 hours.    If you try to set this number higher, you will
get an error message.

Company Name:
The name stored in this box, is the name which will appear on all printouts, and on the on-
screen message pad as the heading, and is limited to 30 characters.        It is, therefore, up 
to the user as to how the pad heading will appear.

Telephone Message Retention:
Normally, telephone messages are discarded after deletion.    Some companies, however, 
wish to retain these discarded messages for future reference, should the need arise.    The 
Message Center can save these deleted messages in a permanent file.    The viewer for 
these messages, however, is available separately.    If you want messages retained, mark 
the checkbox in this area.



Personal Preferences... 
The following defaults can be set in the Personal Preferences dialog box.    If password protection 
is turned on, each person's preferences are saved, and then loaded every time that user logs on.    
If password protection is off, these preferences become global to everyone on the system, so 
when you change the settings with password protection off, you change it for everyone.    In turn, 
they can change these settings system wide too.    Possible settings are:

Date Range:
The default date range is used when deleting or printing messages.    Each choice is 
based on the number of days prior to today's date, and you can choose from 30, 60 or
90 days.

Printer Modes:

Either choose "Print Slips" or "Print Lists".      Slips printed in full from the computer 
are the slowest to print, due to the time involved outputting the graphics, but they 
look nice.    If you need info in a hurry, print lists instead.

General Settings:
There are three checkboxes located in this frame:

System Notification Warning Sound On:
Applies to warning sounds set within Windows to correspond to the icons in the 
message box on the screen.    If no sound device is attached to the system, the 
system will sound a regular Windows beep through the speaker.    If this item is set 
off, no sound will be played, unless the situation requires a critical choice.

Display Minor Alert Messages:
Toggles minor messages on or off.    Minor messages are notifications that help the
new user out.    For instance, when one tries to scan further than the first or last 
message for a selected employee, there is a notification.    If this checkbox is 
turned off, these minor messages will be suppressed.    Major notifications can not 
be suppressed.

Print Message Info in Italics:
When messages are printed, they are printed in normal Helvetica type.    If you turn 
this item on, info that's printed on the slips will be in italics (the item identifiers on 
the printouts say as normal type, and only the changeable information is affected).

New Message Waiting Alert Tone:
When you have a new message waiting,    the Message Center for Windows has to let 
you know, even while TMCFW is iconized.    This listbox has seven alert sounds, or 
[none] if no tone is desired.    A "Test" button is provided to demo all of the sounds, but
is disabled when "None" is chosen.

After you have made your choices, choose "OK" to save the changes you made, or "Cancel" 
to quit and return to the main window without saving your changes.



Operating the Main Window:    (also see The Message Pad Diagram)

"To:" ComboBox (Employees)
The employee combobox, located at the "To:" prompt on the message pad, is the main focus 
point of the Message Center for Windows.    In    Normal Mode, when an employee's name is 
chosen, a search is initiated which retrieves all message and status information about that 
employee.
During message scans, a click on an employee in this combobox loads markers for all 
messages for that employee into the "Who:" combobox on the pad.    Each line in the "Who:" 
list shows the date and time of the call , as well as the caller's name.      If the user clicks on the
"Non-Employees, Visitors" item in this combobox, the "Who:" combobox is filled with the date
and time of the call, as well as the person called, since they all fall under the category of the 
same employee name, Non-Employees, Visitors.
When in New Mode and a    new message is being created, a click here fills the "Who:" 
combobox with a sorted list of frequent callers for the selected employee, and automatically 
drops the list down so you can make a choice.    

"Who:" ComboBox (Message & Frequent Caller Listings):
The "Who:" combobox serves two purposes.    In normal mode, existing messages for the 
selected employee are listed here, by date, time, and caller name.    In new mode, this reflects 
the frequent callers for the selected employee.
When a selection is made from this control in Normal Mode, the selected item, and indicator 
for a telephone message, that chosen message is displayed on the pad.
In New Mode, a selection here yields the appropriate information for the selected frequent 
caller.    The caller's name is inserted into the "Who:" editbox, the caller's company is inserted 
into the "Of:" box, and the telephone numbers are stored into the "Tel:" combobox list.    

"Tel:" ComboBox (Phone Numbers):
The "Tel:" combobox shows only one phone number while in Normal Mode, the phone number
that corresponds to the on-screen message.
When a new message is being created, once an employee is chosen from the list, and a 
frequent caller is also chosen, the "Tel:" combobox is filled with three phone numbers.    These
are "W: " for the work number, "H: " for the home number, and "O: " for an other number.    The
frequent callerinformation can be edited from the "Frequent Caller Maintenance" menu choice 
from the "File" menu.

"Add a Message" Button:
This button is used to initiate the creation of a new telephone message.    Once pressed, the 
user is presented with a clear pad on which to record the new message.    After activation, this 
button disappears, replace by the "Save" and "Cancel" buttons.    When "Add A Message" is 
pressed, the employee dropdown combobox drops down, ready for you to make your choice.

Call Criteria Checkboxes:
These checkboxes, located in the middle of the message pad, allow the user to input specific 
criteria for the call.    They may be chosen during the entry of a new message, and can only be 
changed for the amount of time set in the "System Defaults" menu choice from the "Settings" 
menu.

Message Editbox:
Located in the lower portion of the message pad, the message editbox is where the message 
rhetoric is placed.    The message is limited to 300 characters, numbers, or punctuation marks, 



including spaces..



Normal Mode:
Normal Mode is the standard state of The Message Center for Windows when it initiates.    
TMCFW is always in Normal Mode, unless a message is being entered or edited.    In Normal 
Mode, the "Who:" combobox is filled with message listings for the selected employee.

"NORMAL MODE" shows at the top center of the message pad.



New Mode:
New Mode is only in effect when a new telephone message is being created, or an old 
message is being edited.    During New Mode, the "Who:" combobox, is filled with the names of
frequent callers for the selected employee.

"NEW MODE" appears at the top center of the message pad when a new message is being 
created.



Editing Mode:
When an on-screen message is being edited, you are in editing mode.      You can only modify 
the call criteria and the messageitself.    The employee name, date, time, caller, caller's 
company, telephone, and extension become permanent once a message is saved.

"EDITING MODE" appears at the top center of the message pad when editing mode is active.
 



Frequent Callers:
Frequent Callers are people who call a specific employee on a frequent basis.    What 
determines "frequent" is up to the user.    Generally, someone who calls for a specific person 
once or twice a day can be considered a frequent caller.



Deleting Messages:
Telephone messages can be marked or unmarked for deletion by all users by clicking in the    
"Now Active/Deleted" toggle button on the main message pad  .  , but this only MARKS the message 
for deletion.    Actual removal may only be carried out by a Master Access user.

Deleting and permanently removing existing telephone messages is easy for the Master Access 
user.    Choose the "Delete Messages" choice from the File Menu.    A Deletion dialog window will 
then open.    It is in this dialog window that you choose the Deletion Criteria listed below:

All Messages for 1 Employee:
Click on the "All messages for 1 employee" radio button, then select an employee from the
Employee listbox.    You will be presented with a confirmation dialog box.    If you choose 
OK... ALL MESSAGES FOR THE SELECTED EMPLOYEE WILL BE DELETED.    If this is not 
what you want to do, choose Cancel.

Date Range of Messages for 1 Employee:
Click on the "Date Range of Messages for 1 Employee" radio button, then select an 
employee from the Employee listbox.    The default date range will be entered automatically
for you in the appropriate boxes.    If the deletion setup is satisfactory, click on "OK," and 
you will be asked to confirm the deletion.    Choose "OK" if the selection is correct.      ALL 
MESSAGES FOR THE SELECTED EMPLOYEE DURING THE DATE RANGE SPECIFIED 
WILL BE DELETED.    If this is not what you want to do, choose Cancel.

All Messages in File:
Simply speaking, this is complete and final.    If you click the "All messages in file" radio 
button, then OK, you will be given one last opportunity to Cancel if you wish.    However, if 
you proceed straight through, ALL MESSAGES IN THE MESSAGE FILE WILL BE 
DELETED!    THIS OPERATION IS PERMANENT!    If this is not what you want to do, choose 
Cancel.

Date Range of Messages:
Click on the "Date range of messages" radio button.    The default date range for the 
deletion will be loaded into the appropriate editboxes for you.    Choose OK, and a 
confirmation box will come up.    If you choose OK in the confirmation dialog box, ALL 
MESSAGES FALLING WITHIN THE DATE RANGE WILL BE DELETED!    If this is not what 
you want to do, choose Cancel.



Printing Messages:
Telephone messages can be printed two ways in The Message Center for Windows.    The first 
method produces graphic telephone message slips, four up on a page in portrait mode.    The 
second method produces a straightforward text list of messages.    One employee's messages can
be printed, as well as all messages in the file, or a date range of messages, etc.    Most of the items
in the dialog box have been entered for you.    Simply choose an employee.    In most cases, the 
loaded defaults, which may be changed in the "Personal Preferences" choice from the "Settings" 
menu,    will be fine for your printout.

The first step in printing telephone messages is to choose the "Print..." menu choice from the 
"File" menu.    You will be presented with the Print Messages dialog box.

The second step is to make all of the appropriate selections in the "Print Messages" dialog box.    
Choose the group of messages to be printed, i.e. All Messages for One Employee, Date Range of 
Messages for 1 Employee, All Messages in the File, or simply,    A Date Range of Messages.    If you
select Messages for One Employee choose the employee for whom you want printed messages by
clicking in the employee ComboBox.    If you select A Date Range of Messages, enter the starting 
and ending dates where provided.    (Defaults will be entered for you based upon the choices you 
made in the 'Personal Preferences" dialog box. 

Next, select whether you want to "Print Slips" or "Print Lists" by choosing the corresponding 
radio button. Message Slips are printed on 8.5" x 11" plain or pre-printed forms in portrait mode.    
When you are satisfied with your choices, choose the "OK" button to continue, or the "Cancel" 
button to abandon the operation.

PLEASE NOTE:    The printed Message Slips look nice, but take a while to produce, especially on 
dot matrix printers.    



Adding a New Message: (also see The Message Pad Diagram)

Any user can add a new telephone message.    The steps are as follows:

Initiate New Mode with the "Add a Message" button
It all starts by clicking or tabbing to and selecting the "Add a Message" button, located under 
the message pad on the right side of the main screen.    This activates New Mode. 

The time and date are automatic!
The date and time of the call are entered into the message pad automatically, as soon as "Add 
a Message" button is pressed..

Enter the employee called...
If the person being called is an employee, he or she should already be on the Employee List, 
so selecting that person's name is as simple as making your choice from the "To:" dropdown 
combobox.      This action will load all of that employee's frequent callers and their respective 
information into the "Who:" dropdown combobox.    

If, on the other hand, the person being called is a Visitor, enter that person's name in the edit 
box portion of the "To:" combobox directly.    When the message is saved, the system will 
notify you that it is about to append "NE: " to the beginning of this visitor's name, for easy 
retrieval later.

Enter caller information or choose a frequent caller...
Enter caller information in the "Who:" dropdown combobox on the message pad.    Enter the 
company name of the caller, if this applies. Enter the phone number and extension of the 
caller in the extension editbox. 

 Or...if the caller is a frequent caller of the selected employee, simply click on the frequent 
caller's name from the "Who:" combobox, and all pertinent information will be entered into the
message.    This information may be changed by clicking on the appropriate field, or by typing 
in the change.    Telephone numbers for Frequent Callers are listed in the Telephone dropdown 
combobox.    There are phone numbers for Office, Home, and Other.    (Frequent Caller info can 
be modified in "Frequent Caller Maintenance"    choice from the "File" menu).

Choose the appropriate call criteria checkboxes...
Either tab through the call criteria, changing the criteria checkboxes state with the spacebar, 
or make the appropriate selections with the mouse.    The criteria tell the recipient about the 
call.

Enter the body copy of the message...
Tab to or click in the message box at the bottom of the message pad.    Then type in the caller's
message, up to 300 characters long, including punctuation.    

Save or Cancel the new message...
After all of the information is entered into the message pad, select the "SAVE" button to save 
the new message to the disk.    You will then be returned to Normal Mode.    Should you choose
to discard the message before it is saved, click on the "CANCEL" button to discard the 
message info on the screen and return to normal mode.




